Notices

© Agilent Technologies, Inc. 2015

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
G1701-90112

Edition
Seventh edition, October 2015
Fifth edition, October 2014
Fourth edition, March 2014
Third edition, August 2013
Second edition, June 2013
First edition, March 2013

Printed in USA
Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA 95051

Acknowledgements
Microsoft®, Windows 7®, and Excel® are registered trademarks of Microsoft Corporation in the U.S. and/or other countries.
HP® is registered trademark of HP Company in the U.S. and/or other countries.
Canon® is registered trademark of Canon Inc. in Japan and/or other countries.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights
If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Contents

1 General Information
   Supported Software for GC/MS Systems 6
   Requirements for Hardware and Windows OS Settings 7
   Workflow for Installing Software 9

2 Installation and Configuration
   Step 1. Prepare for Installation 12
   Step 2. Install MassHunter GC/MS Data Acquisition 14
      New or Upgrade Installation of MassHunter GC/MS Data Acquisition 14
      Service Pack Installation of MassHunter GC/MS Data Acquisition 19
   Step 3. Install GC Firmware Update Tool 20
   Step 4. Install MassHunter Qualitative Analysis 21
      New Installation of MassHunter Qualitative Analysis 21
      Service Pack Installation of MassHunter Qualitative Analysis 22
   Step 5. Install MassHunter Quantitative Analysis including Compliance and Quantitative Reporting 23
      New or Upgrade Installation of MassHunter Quantitative Analysis including Compliance and Quantitative Analysis Reporting 23
      Service Pack Installation of MassHunter Quantitative Analysis 26
   Step 6. Install MassHunter Quantitative Analysis Supplemental (Optional) 27
   Step 7. Install MSD ChemStation Data Analysis (Single Quad Only) 28
Step 8. Install MassHunter GC/MS Translator (Optional)  

Step 9. Install MassHunter MRM Acquisition Optimization Assistants (Optional)  

Step 10. Install MassHunter LC/SQ ChemStation Integration Software (Optional)  

Step 11. Install Microsoft Excel  

- Procedure for Installing and Activating Excel 2013 with Internet Connection  
- Procedure for Installing and Activating Excel 2013 without Internet Connection  
- Procedure for Installing and Activating Excel 2010  

Step 12. Configure Microsoft Excel  

Step 13. Configure GC/MS Instruments  

Step 14. Install Agilent GC/MS Software Information and Manuals (Optional)  

Step 15. Install Agilent GC and GC/MS User Manuals and Tools (Optional)  

A  Microsoft Backup and Restore  

- Procedure for Backing Up Your System Image  
- Procedure for Restoring Your Computer from System Image Backup  

B  Configuring Windows Firewall for MassHunter GC/MS Acquisition Software  

- Procedure for Turning Windows Firewall On  
- Procedure for Allowing Programs and Features Through Windows Firewall  
- Adding programs to Windows Firewall Allowed list  
- Procedure for Turning Windows Features On or Off
1 General Information

Supported Software for GC/MS Systems  6
Requirements for Hardware and Windows OS Settings  7
Workflow for Installing Software  9

This chapter lists supported software for GC/MS systems and peripheral requirements and recommended Windows OS settings. It also provides the workflow for installing software and what programs are available on each installation media.
Supported Software for GC/MS Systems

This section lists the supported software for Agilent GC/MS systems, which include:

- Single Quadrupole (SQ)
- Triple Quadrupole (TQ)
- Quadrupole Time-Of-Flight (Q-TOF)

Table 1  Agilent GC/MS Software Media

<table>
<thead>
<tr>
<th>Software Installation Media</th>
<th>Version</th>
<th>Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>MassHunter Workstation GC/MS Acquisition Software</td>
<td>B.07.04</td>
<td>1 DVD</td>
</tr>
<tr>
<td>MassHunter Workstation Qualitative Analysis Software</td>
<td>B.07.00 SP2</td>
<td>1 DL DVD</td>
</tr>
<tr>
<td>MassHunter Workstation Quantitative Analysis Software</td>
<td>B.07.01 SP1</td>
<td>2 DL DVD</td>
</tr>
<tr>
<td>MSD ChemStation Data Analysis Software*</td>
<td>F.01.03</td>
<td>1 CD</td>
</tr>
<tr>
<td>MassHunter Workstation GC/MS Supplemental Software</td>
<td>B.07.04</td>
<td>1 CD</td>
</tr>
<tr>
<td>MassHunter Workstation LC/MS Supplemental Software</td>
<td>B.07.00 SP1</td>
<td>1 CD</td>
</tr>
<tr>
<td>Agilent GC/MS Software Information and Manuals</td>
<td>B.06.00</td>
<td>1 USB Flash Drive</td>
</tr>
<tr>
<td>Agilent GC and GC/MS User Manuals and Tools</td>
<td>B.01.12</td>
<td>3 DL DVD</td>
</tr>
</tbody>
</table>

* MSD ChemStation Data Analysis media is only included in shipment if G1701FA/G1710FA Option 220 or 230 is ordered.

Table 2  Microsoft Excel or Office Media

<table>
<thead>
<tr>
<th>Software Installation Media</th>
<th>Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Excel 2010 (ENG, JPN) and Microsoft Office 2010 (CHN)</td>
<td>1 DVD</td>
</tr>
<tr>
<td>Microsoft Excel 2013 (ENG, JPN, CHN, RUS)</td>
<td>Online Only (No Media)</td>
</tr>
</tbody>
</table>

NOTE  Microsoft Excel is required if you want to run reports for MassHunter Workstation Qualitative Software or MassHunter Workstation Quantitative Analysis Software.
Requirements for Hardware and Windows OS Settings

This section lists the hardware requirements (Table 3) and recommended Windows OS settings (Table 4) for the computer that runs GC/MS software.

Table 3  Requirements for PC, Monitor, and Printer

<table>
<thead>
<tr>
<th>Hardware</th>
<th>GC/Single Quadrupole MSD</th>
<th>GC/Triple Quadrupole</th>
<th>GC/QTOF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 7 Pro SP1 64-bit</td>
<td>Windows 7 Pro SP1 64-bit</td>
<td>Windows 7 Pro SP1 64-bit</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>500 GB minimum</td>
<td>500 GB minimum</td>
<td>2 TB minimum</td>
</tr>
<tr>
<td>Random Access</td>
<td>8 GB minimum</td>
<td>8 GB minimum</td>
<td>8 GB minimum</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB minimum</td>
<td>8 GB minimum</td>
<td>8 GB minimum</td>
</tr>
<tr>
<td>Network Interface</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Controller</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monitor</td>
<td>21.5-inch Wide Screen</td>
<td>21.5-inch Wide Screen</td>
<td>Dual 21.5-inch Wide Screen</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1680 x 1050 minimum</td>
<td>1680 x 1050 minimum</td>
<td>1680 x 1050 minimum</td>
</tr>
<tr>
<td>Supported Printer</td>
<td>HP LaserJet P3015d</td>
<td>HP LaserJet P3015d</td>
<td>HP LaserJet P3015d</td>
</tr>
<tr>
<td></td>
<td>HP LaserJet P3015dn (US only)</td>
<td>HP LaserJet P3015dn (US only)</td>
<td>HP LaserJet P3015dn (US only)</td>
</tr>
<tr>
<td></td>
<td>Canon LBP3310 (JPN only)</td>
<td>Canon LBP3310 (JPN only)</td>
<td>Canon LBP3310 (JPN only)</td>
</tr>
<tr>
<td></td>
<td>Canon LBP6700 (JPN only)</td>
<td>Canon LBP6700 (JPN only)</td>
<td>Canon LBP6700 (JPN only)</td>
</tr>
<tr>
<td></td>
<td>Canon LBP6710i (JPN only)</td>
<td>Canon LBP6710i(JPN only)</td>
<td>Canon LBP6710i(JPN only)</td>
</tr>
</tbody>
</table>

* Windows 7 Pro SP1 64-bit is pre-loaded on Agilent GC/MS bundled PCs.
## Table 4  Windows 7 Pro SP1 64-bit OS Settings for GC/MS PC

<table>
<thead>
<tr>
<th>Windows OS Settings</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Options</strong></td>
<td><strong>High performance</strong></td>
</tr>
<tr>
<td></td>
<td>• Turn off the display: <strong>15 minutes</strong></td>
</tr>
<tr>
<td></td>
<td>• Put the computer to sleep: <strong>Never</strong></td>
</tr>
<tr>
<td><strong>Region and Language</strong></td>
<td><strong>Administrative &gt; Change system locale</strong></td>
</tr>
<tr>
<td></td>
<td>• Current system locale: must select the language of MassHunter software (i.e. English, Chinese, Japanese, or Russian)</td>
</tr>
<tr>
<td><strong>Screen Saver</strong></td>
<td><strong>Blank</strong></td>
</tr>
<tr>
<td></td>
<td>• Wait: <strong>10 minutes</strong></td>
</tr>
<tr>
<td></td>
<td>• On resume, display logon screen: <strong>Checked</strong></td>
</tr>
<tr>
<td><strong>User Account Control Settings</strong></td>
<td><strong>Default - Notify me only when programs try to make changes to my computer</strong></td>
</tr>
<tr>
<td></td>
<td>• Don’t notify me when I make changes to Windows settings</td>
</tr>
<tr>
<td><strong>Windows Firewall</strong></td>
<td><strong>Turn on Windows Firewall</strong></td>
</tr>
<tr>
<td></td>
<td>• Notify me when Windows Firewall blocks a new program: <strong>Checked</strong></td>
</tr>
<tr>
<td><strong>Windows Update</strong></td>
<td><strong>Check for updates but let me choose whether to download and install them</strong></td>
</tr>
<tr>
<td></td>
<td>• Give me recommended updated the same way I receive important updates: <strong>Checked</strong></td>
</tr>
<tr>
<td></td>
<td>• Allow all users to install updates on this computer: <strong>Checked</strong></td>
</tr>
</tbody>
</table>

* If you encounter problems updating MS firmware, you can temporarily turn off the Firewall before performing MS firmware update. Once done with the firmware update, you should turn the Firewall back on again.
Workflow for Installing Software

Figure 1 and Figure 2 show the recommended order for installing GC/MS software, tools, and user manuals on the PC.

| Figure 1 | Workflow for installing software |
Workflow for Installing Software

<table>
<thead>
<tr>
<th>Microsoft Excel or Office Software (No Media for Excel 2013 and later)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Excel (Required for MassHunter Qualitative Analysis and MassHunter Quantitative Analysis)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Agilent GC/MS Software Information and Manuals USB (Optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Manuals</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Agilent GC and GC/MS User Manuals and Tools DVD (Optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Manuals</td>
</tr>
</tbody>
</table>

**Figure 2** Workflow for installing software (continued)
2

Installation and Configuration

Step 1. Prepare for Installation  12
Step 2. Install MassHunter GC/MS Data Acquisition  14
Step 3. Install GC Firmware Update Tool  20
Step 4. Install MassHunter Qualitative Analysis  21
Step 5. Install MassHunter Quantitative Analysis including Compliance and Quantitative Reporting  23
Step 6. Install MassHunter Quantitative Analysis Supplemental (Optional)  27
Step 7. Install MSD ChemStation Data Analysis (Single Quad Only)  28
Step 8. Install MassHunter GC/MS Translator (Optional)  30
Step 9. Install MassHunter MRM Acquisition Optimization Assistants (Optional)  32
Step 10. Install MassHunter LC/SQ ChemStation Integration Software (Optional)  33
Step 11. Install Microsoft Excel  34
Step 12. Configure Microsoft Excel  44
Step 13. Configure GC/MS Instruments  49
Step 14. Install Agilent GC/MS Software Information and Manuals (Optional)  55
Step 15. Install Agilent GC and GC/MS User Manuals and Tools (Optional)  58

This chapter provides installation procedures for Agilent MassHunter GC/MS software and applies to the versions listed in Table 1 and Table 2 and higher, until superseded.

CAUTION
MassHunter Workstation, MSD ChemStation, and Microsoft Excel software must be installed and set up in the sequential order described in this guide, or the software will not work properly.
Step 1. Prepare for Installation

MassHunter GC/MS Acquisition, MassHunter Qualitative Analysis, MassHunter Quantitative Analysis, and MSD ChemStation Data Analysis (see versions in Table 1 on page 6) are fully supported on Windows 7 Professional SP1 64-bit, which is pre-loaded on the Agilent GC/MS bundled PCs.

Support for MassHunter GC/MS Acquisition B.07.02 and later on Windows 7 Enterprise 64-bit is limited to “best efforts”, which means that while a certain result is not guaranteed, good-faith efforts will be made to achieve the best result in the circumstances.

1 If an older version of the software is already installed on the PC, you may need to uninstall it and any service pack before installing the new version. Refer to Table 5 for software that you need to un-install prior to upgrading to a new one. It is recommended that you uninstall the software first in the reverse order of the “Workflow for Installing Software” on page 9.

a To uninstall a program, click Start > Control Panel > Programs and Features, select the software you want to remove, and click Uninstall.

Table 5  Older Software Requiring Un-installation Prior to Upgrading

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MassHunter GC/MS Acquisition</td>
<td>B.07.00 SP1 and earlier</td>
</tr>
<tr>
<td>MassHunter Qualitative Analysis</td>
<td>B.05.00 and earlier</td>
</tr>
<tr>
<td>MassHunter Quantitative Analysis</td>
<td>B.05.00 and earlier</td>
</tr>
</tbody>
</table>

If upgrading from MassHunter GC/MS Acquisition B.07.01 and later, you do not need to uninstall the previous version. The installer will automatically detect and uninstall the previous version for you before it installs the new version.

MassHunter Qualitative Analysis B.07.00 can co-reside (installed side-by-side) with versions B.06, B.05, and B.04. Unless you plan to exactly duplicate data creation, it is recommended that you uninstall any earlier version(s) before installing the new one.

If updating to a Service Pack version, do not remove the base version (for example B.07.00). The Service Pack requires the base version to be already installed on the PC.
2 Run **Windows Update** to make sure you have the latest critical update and security fixes. For Windows 7, click **Start > Control Panel > Windows Update** (if Control Panel is set to “View by: Large icons” or “View by: Small icons”).

3 Verify **Windows Update** is completed before you continue.

4 Verify that Windows OS Settings are configured as recommended in Table 4 on page 8.

**CAUTION**

If you not run **Windows Update**, your system may be vulnerable to security problems. See Table 4 on page 8 for the recommended Windows Update settings.
Step 2. Install MassHunter GC/MS Data Acquisition

New or Upgrade Installation of MassHunter GC/MS Data Acquisition

Perform this procedure to do a new or upgrade installation of MassHunter GC/MS Data Acquisition. New installation means installing the software on the PC where no previous version is installed. Upgrade installation means installing a new version of the software over the previous version. For updating to a service pack version, please refer to “Service Pack Installation of MassHunter GC/MS Data Acquisition” on page 19.

NOTE

Upgrade installation is available with MassHunter GC/MS Data Acquisition B.07.01 and later. If you are upgrading from version B.07.00 or earlier, you need to uninstall the older version first. Refer to “Step 1. Prepare for Installation” on page 12 for more details.

1. Verify that no other program, including Windows Update, is running on your computer.

2. From the MassHunter Workstation GC/MS Acquisition Software disk, right-click on setup.exe and select Run as administrator to install software.

3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

4. Select the language for the installation and click OK.

5. If you see required programs in Pending status, click Install to begin. Depending on what is already installed on your PC, the list of required programs that appears on your PC may be different than the one shown in Figure 3 on page 15.
Step 2. Install MassHunter GC/MS Data Acquisition

Figure 3  Programs required by MassHunter GC/MS Data Acquisition

6 During installation of Microsoft .NET Framework 4.5, you may be asked “Do you want Setup to close your programs?”, click Yes.

7 After Microsoft .NET Framework 4.5 is done installing, the PC will automatically shutdown and restart. After the PC restarted, login using the user name with administrator privileges that you used earlier.

8 If this is a new installation, click Install to continue installing the remaining programs in Pending status.

   If this is an upgrade installation, select the language for the installation and click OK. Then click Install to continue installing the remaining programs in Pending status.

9 In the Welcome to the Installation Wizard for Microsoft System CLR Types for SQL Server 2012 window, click Next.

10 In the License Agreement window, read the license agreement, select I accept the terms in the license agreement, and then click Next.

11 In the Ready to Install the Program window, click Install to begin installing Microsoft System CLR Types for SQL Server 2012.

12 In the Completing the Microsoft System CLR Types for SQL Server 2012 installation, click Finish. The installer automatically proceeds with the installation of Microsoft ReportViewer 2012.
Step 2. Install MassHunter GC/MS Data Acquisition

13 If this is a new installation, click Next in the Welcome to the InstallShield Wizard for Agilent MassHunter GC/MS Data Analysis window to begin installing Agilent MassHunter GCMS Data Acquisition.

If this is an upgrade installation:

- Click Yes in the Confirm Upgrade window to upgrade Agilent MassHunter GC/MS Data Acquisition which will also update the Agilent GC Drivers and Agilent Parts Finder, if installed. In addition, the MassHunter GC/MS Data Acquisition Compliance product will be un-installed if it is present.
- Click Next in the Welcome to the InstallShield Wizard for Agilent MassHunter GC/MS Data Analysis window.

![Figure 4](image)

Figure 4 Confirm Upgrade MassHunter GC/MS Data Acquisition

14 In the License Agreement window, read the license agreement, select I accept the terms in the license agreement, and click Next to continue.

15 In the Feature Type window (Figure 5), choose one from the following and click Next.

- **Standard Workflow**
  Standard workflow. No audit trail, user roles or compliance feature will be installed.

- **Activate User Management and Audit Trail Only**
  Enables Viewer, Reasons Management and Prompt Dialogs (Audit Trail always occurs).

- **Activate Compliance**
  Compliance support features with ECM will be installed. This option requires that the computer is connected to an ECM server and the ECM client is already installed on this computer.
Step 2. Install MassHunter GC/MS Data Acquisition

If you select the **Activate Compliance** mode, make sure that the ECM server is connected to the PC and the ECM client is already installed on the PC. Please refer to the **Agilent MassHunter Compliance Administrator Guide (P/N G6845-90022)** for details on how to:

- **Set up the ECM server** to use with MassHunter GC/MS Data Acquisition B.07.03 in Compliance mode and MassHunter Quantitative Analysis B.07.01 in Compliance mode

- **Install the ECM Workstation Client** on the PC **before** you install MassHunter GC/MS Data Acquisition B.07.03 in Compliance mode and MassHunter Quantitative Analysis B.07.01 in Compliance mode

![Agilent MassHunter GC/MS Data Acquisition - InstallShield Wizard](image)

**Figure 5** Feature Types for MassHunter GC/MS Acquisition

16 If this is a new installation, click **Next** in the **Destination Folder** window to accept the default destination location, which is C:\GCMS\. You may change to a different location by clicking **Change**.

If this is an upgrade installation, the destination folder will be the same location where the previous software version is installed. You cannot change this location unless you remove the previous version from the PC first and then install the new version.

17 In the **Choose location for customer data files** window, click **Next** to accept the default data file location, which is D:\MassHunter\. You may change to a different location by clicking **Change**.
Step 2. Install MassHunter GC/MS Data Acquisition

If this data file location has been specified in previous installation of Agilent MassHunter Workstation software, changing this default location will prevent easy access to old data files and methods stored at this location.

18 In the Ready to Install the Program window, click Install to begin installing or upgrading Agilent MassHunter GC/MS Data Acquisition. The Agilent GC Drivers for MassHunter and Agilent Parts Finder software will also be installed or updated (if older version is currently installed).

19 In the InstallShield Wizard Completed window, click Finish to exit the wizard. See below for list of programs installed by Agilent MassHunter GC/MS Data Acquisition - InstallShield Wizard.

Programs installed by Agilent MassHunter GC/MS Data Acquisition - InstallShield Wizard:

- Microsoft Visual C++ 2005 Service Pack with MFC Security Update
- Microsoft Visual C++ 2008 Service Pack with MFC Security Update
- MSXML 4.0 SP3 (Win7)
- Agilent Installation Qualification Tool
- Microsoft .NET Framework 4.5 Full
- Microsoft Visual C++ 2012 Redistributable Package
- Microsoft SQL Server System CLR Types
- Microsoft ReportViewer 2012
- Agilent MassHunter GC/MS Data Acquisition
- Sequence Table Assistant
- Agilent GC Drivers for MassHunter
- Agilent Parts Finder

NOTE

Desktop icons are created when the installation is successfully completed. The desktop icon for the GC/MS instrument will be created after you complete “Step 13. Configure GC/MS Instruments” on page 49.

If you attempt to open Sequence Table Assistant before Microsoft Excel is installed on the PC, you will get error that Windows can’t open the SequenceTableAssistant.xlsm file. The Sequence Table Assistant will work correctly once Excel is installed.
Service Pack Installation of MassHunter GC/MS Data Acquisition

Perform this procedure to install a Service Pack version of MassHunter Workstation GC/MS Data Acquisition Software on a PC where this software is currently installed with a base version (for example B.07.00).

1 Verify that the base version of MassHunter Workstation GC/MS Acquisition Software (for example B.07.00) is successfully installed on your computer.

If you are installing a Service Pack version of MassHunter GC/MS Acquisition Software (for example B.07.00 SP1), you must install the base version of MassHunter GC/MS Acquisition (for example B.07.00) first and then install the Service Pack version of the software.

2 From the MassHunter Workstation GC/MS Acquisition Software disk, go to the Service Pack directory, right-click on setup.exe and select Run as administrator to install the Service Pack version.

3 If the User Account Control window asks “This file is from an untrusted location. Are you sure you want to run it?” click Yes to continue.

4 Select the language for the installation and click OK.

5 Click Install in the Ready to Install the Program window to begin the installation.

6 Click Finish to exit the wizard.
Step 3. Install GC Firmware Update Tool

Perform this procedure to install the GC Firmware Update Tool.

1. Verify that no other program, including Windows Update, is running on your computer.

2. From the MassHunter Workstation GC/MS Acquisition Software disk, go to the directory \Support\GC Firmware Update Tool, right-click on setup.exe and select Run as administrator to install software.

3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

4. Select the language for the installation and click OK.

5. In the Welcome to InstallShield Wizard for Agilent Technologies GC Firmware Update Tool window, click Next to continue.

6. In the License Agreement window, read the license agreement, select I accept the terms in the license agreement, and click Next to continue.

7. In the Ready to Install the Program window, click Install to begin the installation.

8. In the InstallShield Wizard Completed window, click Finish to exit the wizard.
Step 4. Install MassHunter Qualitative Analysis

New Installation of MassHunter Qualitative Analysis

Perform this procedure to install MassHunter Workstation Qualitative Analysis. If installing a service pack, please refer to “Service Pack Installation of MassHunter Qualitative Analysis” on page 22.

MassHunter Qualitative Analysis B.07.00 can co-reside (installed side-by-side) with versions B.06, B.05, and B.04. Unless you plan to exactly duplicate data creation, it is recommended that you uninstall any earlier version(s) before installing the new one.

1. Verify that no other program, including Windows Update, is running on your computer. Installation of the Qualitative Analysis Software will fail if Windows Update is running, even in the background.

2. From the MassHunter Workstation Qualitative Analysis Software disk, right-click on Setup.exe and select Run as administrator to install software.

3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

4. In the MassHunter Workstation Qualitative Analysis <version number> Setup window, click Install to begin.

5. If you see the message “Microsoft Excel 2010 / 2013 was not detected. You will not be able to generate reports. Do you want to continue the installation?” click Yes. You can install Microsoft Excel at a later time.

6. If you see the message “Current screen resolution is different than the recommended resolution! The recommended resolution is: 1920 X 1080”, click OK. You can change the screen resolution at a later time.

7. In the Welcome to Agilent MassHunter Workstation Qualitative Analysis <version number> Setup Wizard window, click Next to continue.

8. Read the End-User License Agreement. Click I accept the terms in the License Agreement and then Next.

9. In the Choose destination location window, click Next to accept the default folder to install the software, which is C:\Program
Files\Agilent\MassHunter\Workstation\Qual\B.xx.xx, where B.xx.xx denotes the version number.

10 In the Customer Data Files Location window, click Next to accept the default location, which is D:\MassHunter\. 

11 In the Ready to install window, click Install to begin the installation to the specified Destination Folder and Data File Folder.

12 Click Finish to close the Completed the Agilent MassHunter Workstation Qualitative Analysis <version number> Setup Wizard window.

13 Click Close to exit the Setup Successful window.

Service Pack Installation of MassHunter Qualitative Analysis

1 Verify that the base version of MassHunter Qualitative Analysis Software (for example B.07.00) is successfully installed on your computer.

2 From the MassHunter Workstation Qualitative Analysis Software disk, go to the directory Service Packs\SPx (where x is the service pack number), double-click on the appropriate software installer package (*.msi) to install the Service Pack version.

3 Click Next in the Welcome window.

4 Click Install in the Ready to install window.

5 If the User Account Control window asks “Do you want to allow the following program to install software on this computer?” click Yes to continue.

6 Click Finish to exit the installation wizard.
Step 5. Install MassHunter Quantitative Analysis including Compliance and Quantitative Reporting

Perform this procedure to do a new or upgrade installation install or upgrade the MassHunter Workstation Quantitative Analysis Software. New installation means installing the software on the PC where no previous version is installed. Upgrade installation means installing a new version of the software over the previous version. If installing a service pack, please refer to “Service Pack Installation of MassHunter Quantitative Analysis” on page 26.

NOTE
If upgrading from MassHunter Quantitative Analysis B.05.00 and earlier, you need to uninstall the older version first before installing the new one. Refer to “Step 1. Prepare for Installation” on page 12 for more details.

1. Verify that no other program, including Windows Update, is running on your computer. Installation of the Quantitative Analysis Software will fail if Windows Update is running, even in the background.

2. From the MassHunter Workstation Quantitative Analysis Software disk 1/2, right-click on setup_quant.exe and select Run as administrator to install the software.

3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

4. In the Agilent MassHunter Workstation Quantitative Analysis window, read the license agreement, select I accept the terms in the license agreement.

5. The default location to install MassHunter Quantitative Analysis is C:\Program Files\Agilent\MassHunter\Workstation\Quant. If you want to change the default locations, click Change.

6. The default location of the customer data folder is D:\MassHunter\. If you want to change the default locations, click Change.
Step 5. Install MassHunter Quantitative Analysis including Compliance and Quantitative Reporting

The data file location should be the path used by the MassHunter Data Acquisition Workstation to store acquired data.

7 Click Next to continue.

8 In the Choose features to install section, select the features you want to install for MassHunter Quantitative Analysis and MassHunter Quantitative Analysis Reporting. Figure 6 on page 24 shows the default features selected.

![Agilent MassHunter Workstation Quantitative Analysis B.07.01](image)

Choose features to install:

- Agilent MassHunter Workstation Quantitative Analysis B.07.01
- Blank Subtraction Add-in
- Peak Annotations Add-in
- Zero Total Compound Add-in
- Agilent MassHunter Workstation Quantitative Analysis Reporting B.07.01
  - PDF Reporting Templates
  - Excel Addin files
  - Excel Reporting Templates - English (Letter)
  - Excel Reporting Templates - English (A4)
  - Excel Reporting Templates - QRS
  - Excel Reporting Templates - Chinese (Simplified)
  - Excel Reporting Templates - Japanese

Choose compliance type: Standard Workflow

No compliance support features will be installed

Choose desktop icons: Desktop Icons

**Figure 6** Features to install for MassHunter Quantitative Analysis including Compliance and Quantitative Analysis Reporting
9. By default, **Choose compliance type** is set to **Standard Workflow**. You can change the type by clicking on the pull-down menu. The three compliance type options are as follows:

- **Standard Workflow**
  No compliance support features will be installed.
- **Activate User Management and Audit Trail Only**
  Audit Trail and Roles/Capabilities will be installed.
- **Activate Compliance**
  Compliance support features with OpenLAB ECM be installed. This option requires that the computer is connected to the OpenLAB ECM server and that the OpenLAB ECM client is already installed on this computer.

If you select the **Activate Compliance** mode, make sure that the ECM server is connected to the PC and the ECM client is already installed on the PC. Please refer to the **Agilent MassHunter Compliance Administrator Guide (P/N G6845-90022)** for details on how to:

- **Set up the ECM server** to use with MassHunter GC/MS Data Acquisition B.07.03 in Compliance mode and MassHunter Quantitative Analysis B.07.01 in Compliance mode
- **Install the ECM Workstation Client** on the PC before you install MassHunter GC/MS Data Acquisition B.07.03 in Compliance mode and MassHunter Quantitative Analysis B.07.01 in Compliance mode

10. In the **Desktop Icons** window (Figure 7 on page 25), select the check boxes that apply to your instruments. Clear check boxes that do not apply to your instruments. Click **OK** to close the window.

![Desktop Icons](image-url)  
**Figure 7** Desktop Icons for MassHunter Quantitation Analysis
Step 5. Install MassHunter Quantitative Analysis including Compliance and Quantitative Reporting

The GC desktop icon option is for a simplified user interface, showing only GC signals or TIC signals. It does not display the MS spectra, providing a simpler quantitation presentation.

NOTE
After installation, you may add or remove any of these icons by selecting Start > All Programs > Agilent> MassHunter Workstation > Quant Tools > Setup Desktop Icons.

11 Click Install to begin the installation.
12 After installation is completed, click Restart to restart the PC or click Finish to exit the installation wizard and you will need to restart the PC at a later time.

Service Pack Installation of MassHunter Quantitative Analysis

1 Verify that the base version of MassHunter Quantitative Analysis (for example B.07.00) is successfully installed on your computer.

2 From the MassHunter Workstation Quantitative Analysis Software disk, go to the directory Service Packs\SPx (where x is the service pack number), right-click on the appropriate executable file (*.exe) for the software and select Run as administrator to install the Service Pack version.

3 If the User Account Control window asks “Do you want to allow the following program from an unknown publisher to make changes to this computer?” click Yes to continue.

4 Click Update in the Welcome to the Patch for Agilent MassHunter Workstation Quantitative Analysis window.

5 Click Finish to exit the installation wizard.
Step 6. Install MassHunter Quantitative Analysis Supplemental (Optional)

Perform this procedure if you want to install the following supplemental materials to the hard drive:

- Example Data (MS, QQQ, Q-TOF, and TOF)
- Technical Videos
- Report template index
- Manuals

1. From the MassHunter Workstation Quantitative Analysis Software disk 2/2, open the Supplemental folder, right-click on Setup_Supplemental.exe and select Run as administrator.

2. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

3. Select the language for the installation and click OK.

4. Click Next in the Welcome to the InstallShield Wizard window to continue.

5. In the License Agreement window, read the license agreement, select I accept the terms of the license agreement, and click Next to continue.

6. Click Next in the Destination Folder window to accept the default destination location, which is D:\MassHunter\. You may change to a different location by clicking Change.

7. Click Next in the Setup Type window to accept the Complete setup where all program features (listed in bullets above) will be installed. You can choose Custom setup if you want to choose certain program features installed and where they will be installed.

8. Click Install in the Ready to Install the Program window to begin the installation.

9. Click Finish to exit the installation wizard.

10. Verify in Control Panel > Programs > Programs and Features that Agilent MassHunter Workstation Quantitative Analysis Supplemental is installed.

11. To view the supplemental materials, select Start > All Programs > Agilent > MassHunter Workstation > Quant Supplemental.
Step 7. Install MSD ChemStation Data Analysis (Single Quad Only)

Perform this procedure to install MSD ChemStation Data Analysis Software for analysis of single quad GC/MS data.

**CAUTION**

MSD ChemStation Data Analysis software requires .NET Framework 4.0 and Visual C++ 2010 Redistributable. Prior to installing MSD ChemStation Data Analysis, make sure that these programs are already installed on the PC. If not, MSD ChemStation Data Analysis software will not work properly. The installers for these programs are available on the MassHunter Workstation GC/MS Supplemental Software (B.07.00 or higher) CD in the tools folder.

1. Verify that no other program, including Windows Update, is running on your computer.

2. From the MSD ChemStation Data Analysis Software disk, right-click on setup.exe and select Run as administrator to install software.

3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.

4. Select the language for the installation in Choose Setup Language window and click Next.

5. If you see pending status for installing Agilent Installation Qualification Tool, click Install to continue.

6. Click Next in the Welcome to the InstallShield Wizard window to continue.

7. In the License Agreement window, read the license agreement, select I accept the terms of the license agreement, and click Next to continue.

8. Click Install in the Ready to Install the Program window to begin the installation.

9. Click OK when you see the warning “Desktop icons for MSD ChemStation Data Analysis will be created when Instruments are configured or reconfigured.” See Figure 8 on page 29.
Step 7. Install MSD ChemStation Data Analysis (Single Quad Only)

Figure 8  Desktop icons for MSD ChemStation Data Analysis

10 Click **Finish** to exit the installation wizard.
Step 8. Install MassHunter GC/MS Translator (Optional)

Perform this procedure if you want to install MassHunter GC/MS Translator which consists of the following programs:

- **GC AIA Translator** – Converts standard AIA data format to MassHunter data format
- **GC MSD Translator** – Converts GC-MSD ChemStation data to MassHunter data format
- **GC MSD ChemStation Quant Method Translator** – Converts GC-MSD ChemStation Quant method to MassHunter Quant method
- **MSWS Data Translator** – Converts MS Workstation data to MassHunter data format
- **MSWS Quant Method Translator** – Converts MS Workstation Quant method to MassHunter Quant method

**NOTE**

If a previous version already exists on the PC, you will need to uninstall it first before you install the new version. Refer to “Step 1. Prepare for Installation” on page 12 for more details.

1. From the MassHunter Workstation GC/MS Supplemental Software disk, open the GCMS Translator folder, right-click on setup.exe and select Run as administrator.
2. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.
3. Select the language for the installation and click OK.
4. If you see required programs in Pending status such as Microsoft Visual C++ 2010 Redistributable Package (x86), click Install to continue.
5. Click Next in the Welcome to the InstallShield Wizard window to continue.
6. In the License Agreement window, read the license agreement, select I accept the terms in the license agreement, and click Next to continue.
7 Click **Next** in the **Destination Folder** window to accept the default destination location, which is C:\Program Files (x86)\Agilent\MassHunter\GCMS Translator\. You may change to a different location by clicking **Change**.

8 Click **Install** in the **Ready to Install the Program** window to begin the installation.

9 Click **Finish** in the **InstallShield Wizard** window to exit the wizard.
Step 9. Install MassHunter MRM Acquisition Optimization Assistants (Optional)

Perform this procedure if you want to install MassHunter MRM Acquisition Optimization Tools for optimizing triple quadrupole MRM acquisition methods.

- **Compound List Assistant** – Create a method from MRM compound acquisition data stored in a CSV file and a MassHunter template method.
- **Design Experiments Assistant** – Create methods and a sequence used to acquire sample data for optimizing collision energy.
- **Analyze MRM Experiments Assistant** – Automatically analyzes samples run with the sequence from the Design Experiment Assistant to create a new method with optimized collision energies.
- **Dynamic MRM Assistant** – Automatically analyzes existing MRM sample data to determine an optimized mix of time segments and dwell times for best analytical performance. Easily add new compounds to an existing MRM Acquisition Optimized method.

1. From the MassHunter Workstation GC/MS Supplemental Software disk, open the MRM Acquisition Optimization Assistants folder, right-click on setup.exe and select Run as administrator.
2. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.
3. Select the language for the installation and click OK.
4. Click Next in the Welcome to the InstallShield Wizard window to continue.
5. In the License Agreement window, read the license agreement, select I accept the terms in the license agreement, and click Next to continue.
6. Click Next in the Destination Folder window to accept the default destination location, which is C:\Program Files (x86)\Agilent\MassHunter\WorkStation\MRM Acquisition Optimization Tools. You may change to a different location by clicking Change.
7. Click Install in the Ready to Install the Program window to begin the installation.
8. Click Finish to exit the installation wizard.
Step 10. Install MassHunter LC/SQ ChemStation Integration Software (Optional)

Perform this procedure if you want to install the LC/SQ ChemStation Integration Software for translating LC/MS ChemStation data files to MassHunter format so that they can be analyzed with Agilent MassHunter Qualitative Analysis and Quantitative Analysis programs.

1. From the MassHunter Workstation LC/MS Supplemental Software disk, open the MassHunter LC SQ Integration Software folder, right-click on CSIntegrationSetup_xxx.exe and select Run as administrator.

2. If the User Account Control window asks “Do you want to allow the following program from an unknown publisher to make changes to this computer?” click Yes to continue.

3. Click Next in the Welcome to the InstallShield Wizard window to continue.

4. In the License Agreement window, read the license agreement, select I accept the terms of the license agreement, and click Next to continue.

5. Click Next in the Choose Destination Location window to accept the default destination folder, which is C:\Program Files (x86)\Agilent\MassHunter\Workstation\ChemStationIntegration. You may change to a different location by clicking Browse.

6. Click Next in the Choose Customer Data Files Location window to accept the default data file location, which is D:\MassHunter. You may change to a different location by clicking Browse.

7. Click Next in the Start Copying Files window to begin the installation.

8. Click Finish to exit the installation wizard.

NOTE

This data file location has been specified in previous installations of Agilent MassHunter Workstation software. Changing this default location will prevent easy access to old data files and methods stored at this location.
Step 11. Install Microsoft Excel

Perform this procedure if you want to install Microsoft Excel which is required to run reports for MassHunter Workstation Qualitative Analysis and MassHunter Workstation Quantitative Analysis.

NOTE

Agilent MassHunter Workstation Qualitative Analysis and Quantitative Analysis programs support Excel 2010 and 2013 or Office 2010 and 2013. However, Excel 2013 or Office 2013 requires MassHunter Qualitative Analysis B.06.00 SP1 and higher. In Excel 2013, the Add-Ins tab on the ribbon no longer exists and is replaced by MassHunter Reporting tab.

Procedure for Installing and Activating Excel 2013 with Internet Connection

Since Microsoft Excel 2013 package does not come with an installation DVD, you must install or download the software from Microsoft website. If you don’t want to install or download Microsoft Excel 2013 yourself, you can purchase a disk from Microsoft website and have it sent to you.

CAUTION

Internet connection is required in order to install and/or activate Excel 2013. It is possible to install Excel 2013 on a PC without Internet connection, if you have a copy of Excel 2013 installation software from a disk or downloaded from Microsoft website. Internet connection, however, is needed to obtain a secondary product key from Microsoft website in order to activate Excel on PC without Internet connection. See “Procedure for Installing and Activating Excel 2013 without Internet Connection” on page 36 for details.

2. Enter the 25-character Product Key included in the Excel 2013 product packaging and click Get Started.
3. Sign in by entering the email address and password associated with your Microsoft account. If you do not have a Microsoft account, you will need to create an account by clicking Sign up.
You will not be able to install or download Excel if you do not have a Microsoft account. Follow the instructions provided on the Microsoft website to create an account. The Microsoft account team will send you an email and you must follow instructions in the email to finish setting up your account.

4 Once you have successfully signed into your Microsoft account, click **Install** on the “Microsoft Excel 2013 Get Started” page (Figure 9).

![Microsoft Excel 2013 Get Started](image)

**Figure 9**  Microsoft Excel 2013 Get Started

5 You will be prompted to either run or save the program. Click **Run** to install the program now to your computer. If you plan to install the program at a later time, click **Save** to save it to a local drive. However, you will still need Internet connection to proceed with installation and activation of Excel 2013.
6 When you install Excel 2013, the product is automatically activated if you have Internet connection.

**NOTE**

By default, 32-bit version of Excel 2013 is installed. Even if your computer is running 64-bit version of Windows, the 32-bit version of Excel 2013 is recommended. The 32-bit version prevents potential compatibility issues with MassHunter Quantitative and Qualitative software add-ins for Microsoft Excel.

**Procedure for Installing and Activating Excel 2013 without Internet Connection**

It is possible to install Excel 2013 on a PC that is not connected to the Internet. However, you must have the following:

- A copy of Excel 2013 installation software. The copy of the installer may either be from a disk purchased from Microsoft website, downloaded from Microsoft website, or preloaded on the Agilent bundle PC in the D:\ForAgilentServiceProfessionalsOnly\Office15 directory.
- Internet connection on any PC where you can access the Microsoft website at www.office.com/setup in order to obtain a secondary 25-character Product Key. This secondary Product Key is required to activate Excel 2013 that has been installed on a PC without Internet connection.
- Telephone access for activating Excel 2013 on PC without Internet connection.

Perform the following steps to obtain a secondary Product Key from Microsoft website, install, and then activate Microsoft Excel 2013 on a PC that has no Internet connection.

1 On any PC that has Internet connection, perform steps 1 through 3 of the “Procedure for Installing and Activating Excel 2013 with Internet Connection” on page 34 in order to sign in your Microsoft account and obtain a secondary Product Key from the Microsoft website.

2 Once signed in to your Microsoft account, click **Install from a disc** under the Account Options (Figure 9 on page 35).
Step 11. Install Microsoft Excel

3 Click **I have a disc** and then click **View your product key** to get the secondary Product Key for Excel 2013 (Figure 10 on page 37).

![Microsoft Excel 2013 Install from a disc](Figure 10)

4 Write down the 25-character Product Key shown on the screen. You will need to provide this key in a later step when activating Excel 2013 on a PC without Internet connection.

5 Sign out of the Microsoft account.

6 Locate a copy of Excel 2013 installer, which is available:
   - By purchasing a disk from Microsoft website
   - By downloading from Microsoft website
   - On the Agilent bundle PC in the directory `D:\ForAgilentServiceProfessionalsOnly\office15`

7 Right-click `setup.exe` and select **Run as administrator** to install the software.
8 If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?”, click Yes to continue.

9 Without Internet connection, you will see this error message “We are unable to connect right now. Please check your network and try again later. Enter a product key instead.” Click Enter a product key instead (Figure 11).

![Figure 11](Unable to connect to the Internet)

10 In the Enter your product key window (Figure 12), enter the secondary 25-character Product Key you obtained from the Microsoft website when you logged into your account (step 3 on page 37). Do not enter the product key from the card included in the Excel 2013 product packaging.

![Figure 12](Enter your product key window)

11 Click Install and Excel 2013 will be installed in the background. Installation takes a couple of minutes to complete.
12 In the **Welcome to your new Office** window, click **Next** to continue.

13 Select **No thanks** in the **First things first** window. Read the Microsoft Office License Agreement and click **Accept**.

14 Click **No thanks, maybe later** in the **Sign in and get the most of Office** window.

15 Click **Next** in the **Meet SkyDrive** window.

16 Click **No, thanks** in the **Take a look at what's new** window.

17 Click **All done!** in the **You're good to go** window.

18 Click on **Start > All Programs > Microsoft Office 2013 > Excel 2013** to open the program.

19 The **Microsoft Office Activation Wizard** window (Figure 13) appears once Excel opens. Select **I want to activate the software by telephone** and click **Next** to continue.

![Microsoft Office Activation Wizard](image)

**Figure 13**  Microsoft Office Activation Wizard

20 Follow the three steps shown on screen in the Activation Wizard to activate Excel 2013 over the telephone.
Step 1: Select the country/region you are calling from and call the phone numbers provided.

Step 2: When prompted provide the Installation ID shown on screen

Step 3: Listen for the Confirmation ID provided on the phone and enter the numbers given for blocks A through H.

21 Click Next when done entering the Confirmation ID.

22 If the Confirmation ID entered is correct, you will see this message “Thank you. Your copy of Microsoft Excel 2013 is activated. To make your changes take effect, exit and restart any open Office programs.”

23 Click Close to exit the Activation Wizard.

Procedure for Installing and Activating Excel 2010

Perform the following steps to install Microsoft Excel 2010.

1 Close all running programs.

2 Insert the Microsoft Excel 2010 DVD into the optical drive.
3 Enter your 25-character Product Key (included in the product packaging) when prompted and click Continue. Once you have entered a valid Product Key, you should see at the bottom of the window that the Attempt to automatically activate my product online check box is selected.

**NOTE**

Internet connection is required to automatically activate the product online. If you choose to activate your product through the Internet and you are not already connected, the installation wizard alerts you that there is no connection. In this case, follow the on-screen instructions to activate the software by phone. A phone number will be provided on the screen based on the country/region you have selected.

**CAUTION**

If you do not enter the product key, you can proceed with the installation of Excel. However, without a valid Excel product key, report automation with the MassHunter Qualitative Analysis and Quantitative Analysis programs may fail.

4 Read the Microsoft Software License Terms, select I accept the terms of this agreement, and click Continue.

5 Click Install Now in the Choose the installation you want window to install all the default Excel or Office programs.

6 If you want to customize your installation, click Customize.
   a In the Installation Options tab (Figure 15), make sure that the icon next to each of the following programs appear white.
      - Microsoft Excel
      - Office Shared Features
      - Office Tools
   b If not white, click on the drop down menu and select Run all from My Computer.
   c Click Install Now to install the programs.
7 Click **Close** to exit the installation wizard.

8 Open Excel 2010 and if the Activation Wizard (**Figure 16**) appears, it means the software is not activated. Select the option on how you want to activate your software:
  - I want to activate the software over the Internet. (recommended)
  - I want to activate the software by phone.

**NOTE**
Activating the software over the Internet (if connection is available) is recommended because it is automated and quick.
Step 11. Install Microsoft Excel

9 Select the option **I want to activate the software by telephone**, if Internet connection is not available, and then click Next.

10 Follow the three steps shown on screen in the Activation Wizard to activate Excel 2010 over the telephone.

   **Step 1**: Select the **country/region** you are calling from and call the phone numbers provided.

   **Step 2**: When prompted provide the **Installation ID** shown on screen.

   **Step 3**: Listen for the **Confirmation ID** provided on the phone and enter the numbers given for blocks A through H.

11 Click **Next** when done entering the Confirmation ID.

12 If the Confirmation ID entered is correct, you will see the message **Thank you. Your copy of Microsoft Excel 2010 is activated. To make your changes take effect, exit and restart any open Office programs.**

13 Click **Close** to exit the Activation Wizard.
Step 12. Configure Microsoft Excel

Perform this procedure to configure Microsoft Excel to ensure that MassHunter Workstation Qualitative Analysis and MassHunter Workstation Quantitative Analysis reports are properly generated.

1. Open Excel software.

2. Verify the software is activated. Click File > Account in Excel 2013 or File > Help in Excel 2010. On the right side, if you see Product Activated, then the software is activated.

   NOTE

   If you see Activate Product Key, then the product has not been activated. Click Activate Product Key to perform the activation.

3. Verify Excel security for MassHunter Workstation add-ins are configured:
   a. Click File > Options.
   b. Select Trust Center in the Excel Options window (Figure 17) and then click Trust Center Settings.
Step 12. Configure Microsoft Excel

Figure 17 Excel Options Trust Center window

- When the Trust Center window appears, select Macro Settings. The default security is set to Disable all macros with notification.
4 If you plan use report templates that utilize the CustomMakeReport, CustomAfterFormat, CustomAfterImport, or CustomAfterCopy macro, you need to select the following macro settings as shown in Figure 18:

- Enable all macros (not recommended; potentially dangerous code can run)
- Trust access to the VBA project object model

![Figure 18 Trust Center Macro Settings window](image)

**NOTE**
For versions B.05.xx of MassHunter Qualitative Analysis and MassHunter Quantitative Analysis, the Trust access to the VBA project object model check box is required to be selected. However, for version B.06.xx, it is recommended but not required to check this box. Leaving this check box unselected provides the most security in Excel.
Step 12. Configure Microsoft Excel

5 Verify Add-ins are configured for MassHunter Workstation software:
   a Click File > Options.
   b Click Add-Ins in the Excel Options Add-Ins window (Figure 19).

![Excel Options Add-Ins window](image)

**Figure 19** Excel Options Add-Ins window
Step 12. Configure Microsoft Excel

**c** Make sure that **Masshunter Addin Loader** is listed under the **Active Application Add-ins** section as shown in Figure 19.

You may see **Masshunter Reporting Qual** and/or **Masshunter Reporting Quant** listed under the **Active Application Add-ins** section. However, it is not necessary for either of these add-ins to be listed in the **Active Application Add-ins** section. Reporting will work fine as long as the Masshunter Addin Loader is active.

**NOTE**

There is a known issue with Excel that if you manually select the **Masshunter Reporting Quant** check box in the **Add-Ins** window (Figure 20) and click **OK**, when you close and open Excel again, the **Masshunter Reporting Quant** check box in the **Add-Ins** window is cleared as if you did not enable this add-in. However, reporting still works and an Excel report is generated, even though Masshunter Reporting Quant Add-in is not shown as active.

**d** If **Masshunter Addin Loader** is not listed, select **Excel Add-ins** from the dropdown menu next to **Manage** and click **Go**. In the **Add-Ins** window (Figure 20), select the **Masshunter Addin Loader** check box and then click **OK**.

![Figure 20 Excel Add-Ins window](image-url)
Step 13. Configure GC/MS Instruments

Perform this procedure to configure GC/MS instruments with MassHunter Workstation GC/MS Acquisition Software.

If you plan to use MSD ChemStation Data Analysis for single quad data analysis, it is best to configure your GC/MS instrument(s) after the software is installed. If the software has not been installed and you proceed with configuration, you will need to reconfigure the instruments after MSD ChemStation Data Analysis is installed, otherwise the MSD ChemStation Data Analysis software will not work properly.

1. From the desktop, double-click on **Agilent GCMS Configuration** icon, which is created when MassHunter Workstation GC/MS Acquisition is successfully installed.

2. If the **User Account Control** window asks “Do you want to allow the following program from an unknown publisher to make changes to this computer?” click **Yes** to continue.

3. In the **Agilent GC/MS Instrument Configuration** window (Figure 21), select the instrument number button from the toolbar or select **Configure > Instrument x**, where x is instrument number 1 to 4. This will open another **Agilent GC/MS Instrument Configuration** window (Figure 22).

![Figure 21: Agilent GC/MS Instrument Configuration window](image-url)
Step 13. Configure GC/MS Instruments

Figure 22  Detailed GC/MS Instrument Configuration window

4 Enter the **Instrument Name**. This name is used to identify this instrument by its desktop icons.

5 Enter a **Laboratory ID Number** (Optional). This can be a company-specified ID or you could enter the instrument's serial number.

6 For an online instrument, clear the **Offline Instrument** check box. For an offline instrument, select **Offline Instrument** check box.

**NOTE**
If you want to work on an online system in the offline mode, you need to do the following: 1) Configure an online instrument (for example, instrument #1) and then connect to the instrument and resolve any method resolution. 2) Configure an offline instrument (for example, instrument #2) using the same IP address as the online instrument (for example, instrument #1). This will duplicate the GC configuration so that the offline system will be the same as the online system. Offline mode is useful for training or sequence table setup. Some of the MassHunter GC/MS Acquisition software features are not available in offline mode.
7 Select the **Mass Spectrometer Model** of your instrument from the drop down menu:
   - None
   - 5975
   - 5977
   - 7000
   - 7010
   - 7200

8 Enter the IP **Address** of the mass spectrometer.

**NOTE**

For the 7000 (Triple Quad) or 7200 (QTOF) instrument, the recommended IP address is 192.168.254.12. For the 5975 and 5977 (Single Quad) instruments, you can use any available IP address. If the Single Quad instrument is not going to be connected to the network, the recommended MS IP address to use is 10.1.1.102.

9 For 5975 or 5977 Single Quad instrument, select the factory configured **DC Polarity** (Positive or Negative) of this instrument. The DC Polarity is listed on a label on the cover over the RF coils. This cover can be viewed by removing the upper MSD cover.

10 For a 7000 or 7010 Triple Quad or 7200 Q-TOF instrument, click the **Configure** button and the appropriate configure window will appear:
   - Configure Triple Quadrupole Mass Spectrometer Model 70x0
   - Configure Quadrupole Time Of Flight Mass Spectrometer Model 7200

   a Select any available ion source types that apply to your instrument. If you only select the current installed source, MassHunter Workstation GC/MS Acquisition software will not prompt you to enter the source type at startup. If you intend to use two or three of the source types and do not want to change these configuration settings in the future, select all check boxes that apply to this instrument.

   b For a 7000 Triple Quad with high sensitivity electronics, select the **controllable iris** check box.

   c Click **OK** to save the source configuration and return to the **Agilent GC/MS Instrument Configuration** window.
11 In the **Agilent GC/MS Instrument Configuration** window, select the **Gas Chromatograph Model** of your instrument from the drop down menu:
- None
- Other
- 7890 GC
- 7820 GC
- 7810 GC (5975T)
- 6890N GC
- 6850 GC

12 Enter the IP **Address** of your gas chromatograph.

**NOTE**
For the GC that is configured with the 7000 or 7010 (Triple Quad) or 7200 (QTOF) instrument, the recommended IP address to use is 192.168.254.11. If the Single Quad instrument is not going to be connected to the network, the recommended GC IP address to use is 10.1.1.101.

13 If you selected 5977 MS and 7890 GC, then **Enable Direct Communication between instruments** check box is available to select and the **Only enable for 7890B & 5977A, not for others** message is displayed next to the check box.

14 Select a **Workflow Mode** available for your instrument. Workflow modes are available based on the types of **Mass Spectrometer Model** selected.

For a 5975 or 5977 Single Quad instrument, the available workflow modes for data analysis are:
- Enhanced
- Drug Analysis
- EnviroQuant (EPA)
- Aromatics in Gasoline.

**CAUTION**
To use any of the workflow modes with MSD ChemStation Data Analysis, you must have MSD ChemStation Data Analysis installed on the PC. If you want use MSD ChemStation Data Analysis for automated reporting after the data has been acquired, you must select **Use MSD ChemStation Data Analysis** under the Method menu in MassHunter GC/MS Acquisition software.
Step 13. Configure GC/MS Instruments

For a 7000 or 7010 Triple Quad or 7200 Q-TOF instrument, the available workflow modes for data analysis are:

- Enhanced
- Drug Analysis.

15 Click **OK** to save the configuration and close the **Agilent GC/MS Instrument Configuration** window.

16 Click **Yes** in the **Update Configuration** window when asked “Proceed with update to Instrument Configuration?”

17 Select **File > Exit** after the message “Instrument configuration saved” appears at the bottom of the **Agilent GC/MS Instrument Configuration** window.

For a 5975 or 5977 Single Quad instrument that is successfully configured, two desktop icons (Figure 23) are created, if MSD ChemStation Data Analysis is installed:

- One for MassHunter Workstation GC/MS Data Acquisition (identified by <instrument name> that you entered in the configuration)
- One for MSD ChemStation Data Analysis (identified by <instrument name> followed by Data Analysis)

![Figure 23](image)

**Figure 23** MassHunter Acquisition and MSD ChemStation Data Analysis desktop icons

---

**NOTE**

If you want use MSD ChemStation Data Analysis for automated reporting of your collected data, you must select **Use MSD ChemStation Data Analysis** under the Method menu in MassHunter GC/MS Data Acquisition Software. The **Use MSD ChemStation Data Analysis** menu is only visible when MSD ChemStation Data Analysis software is installed on a PC that has MassHunter Qualitative Analysis and/or MassHunter Quantitation software installed.

---

For a 7000 Triple Quad instrument that is successfully configured, only one desktop icon is created:
Step 13. Configure GC/MS Instruments

- MassHunter Data Acquisition (identified by <instrument name> that you entered in the configuration).

For a 7200 Q-TOF instrument that is successfully configured, two desktop icons are created:
- MassHunter Data Acquisition (identified by <instrument name> that you entered in the configuration).
- Agilent QTOF Conditioning
Step 14. Install Agilent GC/MS Software Information and Manuals (Optional)

Perform this procedure to install the extensive library of software Manuals, Tutorials, online Help, Videos, and more for your system.

The Agilent GC/MS Software Information and Manuals USB Flash Drive (UFD) contains Manuals, Online Help, Videos, Familiarization Guides, and Workflow Guides for:

- Shared GC-MS MassHunter Documentation Files
- 5977 Series MSD
- 5975-5973 Series MSD
- 7010-7000 Series Triple Quad MS
- 7200 Series Q-TOF MS
- 7890B/5977A eFamiliarization
- MassHunter Data Analysis
- MSD ChemStation Data Analysis

1. Insert the USB Flash Drive into a USB port.
2. Right-click on Setup.exe and select Run as administrator.
3. If the User Account Control window asks “Do you want to allow the following program to make changes to this computer?” click Yes to continue.
4. In the Choose Setup Language window (Figure 24), select the language for the installation. If available, manuals will be installed in the chosen language. Otherwise, the English version of the manuals will be installed instead.
Step 14. Install Agilent GC/MS Software Information and Manuals (Optional)

5 In the **Welcome to the InstallShield Wizard** window, click **Next** to continue.

6 In the **License Agreement** window, read the license agreement, select **I accept the terms in the license agreement**, and click **Next** to continue.

7 In the **User Manual Selection** window (Figure 25), select the user manuals appropriate for your instrument and click **Next** to continue.
Step 14. Install Agilent GC/MS Software Information and Manuals (Optional)

8 In the **Destination Folder** window, click **Install** to accept the default destination location, which is C:\Program Files (x86)\Agilent Technologies\User Information Software. You may change to a different location by clicking **Change**.

9 Click **Finish** to exit the installation wizard.

10 Icons for the user manuals you have selected will appear on the desktop after the installation is complete.
Step 15. Install Agilent GC and GC/MS User Manuals and Tools (Optional)

Perform this procedure to install the Agilent GC and GC/MS User Manuals and Tools 3-DVD set, which contains:

- **Instrument Manuals (Disc 2 and Disc 3)** - Instrument Manuals for Gas Chromatographs and Accessories, Sample Introduction Instruments, Sample Preparation Instruments, and Mass Spectrometry Instruments.

- **User Videos (Disc 3)** - Fundamentals of Gas Chromatography videos are available for viewing only, not for installation:
  - Introduction and Overview
  - Columns

- **Parts Finder Tool (Disc 1)** - Find parts for 7890A/B GC, 7820A GC, 6890N GC, 7693A and 7650A ALS, 7697A HS, 5977A/B and 5973/5975 MSD, 7010 and 7000A/B/C QQQ GC/MS, and 7200 Q-TOF.

- **Method Developer Tools (Disc 1)** - Backflush Wizard, Method Translators (GC Method Translator and HS Method Translator), and GC Calculators.

- **GC Firmware Update Tool (Disc 1)** - Update firmware for 7890A/B GC, 7820A GC, 5975T GC, 6890 GC, 6850 GC, 7697A Headspace Sampler, 7696A Workbench, and 7667A Mini TD.


1. Insert Disc 1, Disc 2, or Disc 3 into the optical drive and open Welcome.html.

2. When the Language window appears (Figure 26), select the language you want to install.
Step 15. Install Agilent GC and GC/MS User Manuals and Tools (Optional)

**Figure 26** Language window from GC and GC/MS User Manuals and Tools (Disc 1)

3 In the **Home** tab (Figure 27), click on an icon to install the manuals or tools you want.

**Figure 27** Home tab of GC and GC/MS User Manuals and Tools (Disc 1)
Step 15. Install Agilent GC and GC/MS User Manuals and Tools (Optional)

4 Follow the on-screen instructions to continue with the installation.

5 Depending on the disc you inserted and the icon you selected, you may be instructed to insert a different disc to install the desired content. For example, on Disc 2 if you want to install the 5977B HES GC/MS Manuals or 7010 Triple Quadrupole GC/MS Manuals, you will be instructed to insert the appropriate DVD (Figure 28).

![Install Instrument Manuals (Disc 2)](Image)

**Figure 28** Manuals tab of GC and GC/MS User Manuals and Tools (Disc 2)

6 If you want to install the available contents listed under **What's on This Disc** (for example, Disc 2), click on **Install** and then **Run**.

7 If the **User Account Control** window asks “Do you want to allow the following program to make changes to this computer?” click **Yes** to continue.

8 In the **User Manual Selection** window, select the user manual set(s) that you wish to have loaded on your system and then click **Next**.

9 In the **Destination Folder** window, click **Install** to accept the default destination location, which is C:\Program Files (x86)\Agilent\Lab Monitor. You may change to a different location by clicking **Change**.

10 Click **Finish** to exit the installation wizard.

11 Icons for the user manuals you have selected will appear on the desktop after the installation is complete.
It is recommended that you backup your computer on a regular basis to ensure that you can restore the contents of the C:\ and D:\ drives in the event your computer crashes.

The procedures below use Microsoft Windows 7 Backup and Restore program to create an image of the C:\ drive on an external USB drive (or separate physical hard drive) and also to create a Windows recovery disk. The recovery disk and external USB drive (or separate physical drive) are used together to restore the C:\ and D:\ drives to the state of your last backup if ever needed.
Procedure for Backing Up Your System Image

1. Click on **Start > Control Panel**. Select **Backup and Restore** (if Control Panel is set to “View by: Large icons” or “View by: Small icons”) and on the left panel, select **Create a system image** (Figure 29).

![Figure 29](image)

**Figure 29**  Windows Backup and Restore

2. Select the **On a hard drive** option and then select the external USB drive (or separate physical drive) from the pull down menu. Click **Next** to continue (Figure 30).
3 Select which drives you want to include in the backup and click **Next**.

4 Confirm your backup settings and then click **Start backup** (Figure 31). The “System Reserved (System)” and “Programs (C:) (System)” drives will be backed up. On the Agilent bundled PC with all GC/MS software installed, the creation of a system image should take about 30 minutes.
Procedure for Backing Up Your System Image

Figure 31  Confirm backup settings

5  After the process is complete, you will be prompted “Do you want to create a system repair disc?” Click **Yes**.

NOTE

The system repair disk can be used to access system recovery options to help you recover your computer from a serious error, restore your computer from a system image, or boot your computer.

6  Select a CD/DVD drive and insert a blank disk (CD or DVD) into the optical drive. Then click **Create disc**.

7  Once the system repair disk is done burning, click **Close**. Remember to label the disk with name of computer, date of creation, and the Windows operating system version. Make sure to keep the disk in a secure place.

8  Click **OK** when you see “System repair disc complete.”

9  Click **Close** when you see “The backup completed successfully.”
Procedure for Restoring Your Computer from System Image Backup

When the time comes for you to restore your computer, you can do so by using the external USB drive (or physical hard drive) where you backed up your system image and the system repair disc to boot your computer.

When you restore your computer from a system image, it is a complete restoration. You can not choose individual items to restore. All of your programs, system settings, and files are replaced with those on the system image. Once restored, your computer will be an exact copy of the drive(s) at the time the image was created. Everything else from that point on will be gone. Therefore, before you restore, backup any new data that you do not want to lose that is not included in the system image backup.

1. If your system image was saved to an external USB drive, connect the drive to a USB port on the PC to be restored.
2. Insert the system repair disc in the CD/DVD drive and shutdown your computer.
3. Restart your computer using the computer’s power button.
4. When prompted, press any key to boot from CD or DVD. If you don’t do this, the BIOS will attempt to boot from the hard drive.
5. In the System Recovery Options window, select the correct language and keyboard input method before clicking Next.
6. Select Restore your computer using a system image that you created earlier and click Next.
7. In the Select a system image backup screen, select Use the latest available system image, click Next.
8. In the Choose additional restore options screen, no need to select any option. Click Next to continue.
9. The next screen gives you a quick overview of the system image to be restored. Click Finish to start the restore process.
10. A warning message appears asking “Are you sure you want to continue?” Click Yes and a progress window appears.
11. When the restore is complete, you will be prompted Do you want to restart your computer now? The PC will automatically restart in 30 seconds. Select Restart now if you want to reboot the PC without waiting the full 30 seconds.
Windows Firewall can help protect your computer from being accessed by hackers or malicious software through a network or the Internet. For this reason, Agilent recommends that you do turn on Windows Firewall and allow trusted programs such as the ones required by MassHunter GC/MS Acquisition Software to communicate through the firewall.

Perform the following procedures to configure Windows Firewall settings that allow Agilent MassHunter GC/MS Acquisition Software to work properly through a firewall. The instructions in this appendix apply to Microsoft Windows 7 Pro SP1 64-bit.
Procedure for Turning Windows Firewall On

Windows Firewall is installed automatically with Windows Operating System. However, it may or may not be turned on depending on what you selected during Set Up Windows process after the initial power on of your brand new computer.

It is recommended that you select **Use recommended settings** in **Set Up Windows** (Figure 32).

![Figure 32](Set Up Windows after initial PC power on)

When the **Use recommended settings** option is selected, the default firewall settings are:

- The firewall is *on*.
- The firewall is *on* for all network locations (Home or work, Public, or Domain).
- The firewall is *on* for all network connections.
- The firewall is blocking all connections that are *not* on the list of allowed programs.
If you choose the Ask me later option in Set Up Windows, Windows Firewall is turned off by default.

It is recommended that Windows Firewall be turned on to protect your computer.

To turn Windows Firewall on, perform the following steps:

1. Log on to your computer with administrator privileges.
2. Click on Start > Control Panel > System and Security > Windows Firewall. If you do not see System and Security in Control Panel, you can alternatively click Windows Firewall.
3. If you get a Windows Firewall window that looks like Figure 33 on page 68, it means that the computer is being managed by your IT department. You will not be able to make changes to the firewall settings on your own. Please contact your IT department for assistance before continuing.

Figure 33  Windows Firewall managed by your IT department
4 If you get a Windows Firewall window that looks like Figure 34, click Turn Windows Firewall on or off on the left pane.

![Windows Firewall off](image)

**Figure 34**  Windows Firewall off
5 In the **Customize Settings** window (Figure 35), select the following options for each type of network location that you use:

- **Turn on Windows Firewall**
- **Notify me when Windows Firewall blocks a new program**

**CAUTION** Do *not* check **Block all incoming connections, including those in the list of allowed programs**.
6 Click **OK**. Windows Firewall is now turned *on* with the recommended settings (Figure 36 on page 71).

![Figure 36](image)

**Figure 36**  Windows Firewall on

With the **Notify me when Windows Firewall blocks a new program** option selected, when you run a program that is not on the allowed list, the **Windows Security Alert** window (Figure 37 on page 72) appears prompting you to allow the blocked program through the firewall.

When you see the **Windows Security Alert** window, you must click **Allow access** if the program shown is from a trusted publisher or source. Refer to **Table 6** on page 74 for a list of programs that need to be allowed through the firewall in order for Agilent MassHunter Acquisition software to work properly.

**CAUTION** If you click **Cancel** in the Windows Security Alert window, the program will be blocked from communicating through Windows Firewall and will not run.
Procedure for Turning Windows Firewall On

Figure 37  Windows Security Alert window
When Agilent MassHunter GC/MS Data Acquisition is installed on the computer, the software and all of its required components are automatically put on the list of allowed programs and features so the required components can communicate through Windows Firewall.

If you are having issues communicating with GC/MS instruments through the firewall, you should verify that the required programs listed in Table 6 on page 74 have been properly added to the Windows Firewall Allowed list and that the appropriate check boxes are selected for the programs under the Name column and under the Home/Work (Private) or Public column as shown in Figure 38 on page 75.
Procedure for Allowing Programs and Features Through Windows Firewall

Adding programs to Windows Firewall Allowed list

If the required programs are *not* on the list, you will need to add them manually.

1. In the **Windows Firewall** window (Figure 36 on page 71) on the left pane, click on **Allow a program or feature through Windows Firewall**.

2. In the **Allow Programs** window (Figure 38 on page 75), if the program is already on the Allowed programs and features list (also known as the Exceptions list), be sure to check the box next to the program and network location(s) you want to allow communication. You must click **Change settings** first and then select the appropriate check boxes.

### Table 6  Required Programs on Windows Firewall Allowed List

<table>
<thead>
<tr>
<th>Programs</th>
<th>Paths</th>
</tr>
</thead>
<tbody>
<tr>
<td>File and Printer Sharing</td>
<td>Unknown</td>
</tr>
<tr>
<td>File Transfer Program</td>
<td>C:\windows\system32\ftp.exe</td>
</tr>
<tr>
<td>File Transfer Program</td>
<td>C:\windows\syswow64\ftp.exe</td>
</tr>
<tr>
<td>GCDriverEvents</td>
<td>Unknown</td>
</tr>
<tr>
<td>httpdmsd tool</td>
<td>C:\GCMS\msexe\httpdmsd.exe</td>
</tr>
<tr>
<td>instrument control and calibration</td>
<td>C:\GCMS\msexe\msinsctl.exe</td>
</tr>
<tr>
<td>Microsoft Telnet Client</td>
<td>C:\Windows\system32\telnet.exe</td>
</tr>
<tr>
<td>MSD Firmware Update</td>
<td>C:\GCMS\firmware\5973N\msupdate.exe</td>
</tr>
<tr>
<td>MSD Firmware Update</td>
<td>C:\GCMS\firmware\5977N\msupdate.exe</td>
</tr>
<tr>
<td>rpcinfo tool</td>
<td>C:\GCMS\msexe\rpcinfo.exe</td>
</tr>
<tr>
<td>scqiolib tool</td>
<td>C:\GCMS\msexe\scqiolib.exe</td>
</tr>
<tr>
<td>scs tool</td>
<td>C:\GCMS\msexe\scs.exe</td>
</tr>
<tr>
<td>Trivial File Transfer Protocol App</td>
<td>C:\Windows\system32\tftp.exe</td>
</tr>
</tbody>
</table>
3 Once you are done selecting the program(s) on allow to communicate through Windows Firewall, click OK.

![Allowed Programs window](image)

**Figure 38** Allowed Programs window

4 If the program is *not* on the list of **Allowed programs and features**, you can add it to the list by performing the following steps:
   
a Click **Change settings** and then select **Allow another program** in the **Allowed Programs** window (**Figure 38**).
   
b In the **Add a Program** window (**Figure 39**), click **Browse** to open the **Browse** window.
c In the **Browse** window (Figure 40), navigate to the path where the program you want to add is located (refer to Table 6 on page 74), then select the program file, and click **Open**.
d In the **Add a Program** window (Figure 41), verify that the program file you have selected is shown in the **Path** field before clicking **Add**. Once the program is added to the Allowed list, you should see a check mark next to it (Figure 42).

![Figure 41](image1.png)  **Figure 41** Adding a program to Windows Firewall Allowed list

![Figure 42](image2.png)  **Figure 42** Program is added to Windows Firewall Allowed
Procedure for Turning Windows Features On or Off

Programs such as Microsoft Telnet Client and Trivial File Transfer Protocol (TFTP) require that you turn on Windows features from the Programs and Features.

1. Click **Start > Control Panel > Programs and Features** (if Control Panel is set to “View by: Large icons” or “View by: Small icons”).

![Figure 43: Turn Windows features on or off](image)

2. On the left panel of **Programs and Features** window (Figure 43), click **Turn Windows features on or off**.

3. In the **Windows Features** window (Figure 44 on page 79), select the feature you want to turn on by selecting the check box next to its name. To turn off the feature, clear the check box next to its name.

4. Click **OK** to exit the window.
Procedure for Turning Windows Features On or Off

Figure 44  Select Windows features to turn on or off
In This Book

This book contains installation instructions to install or upgrade a copy of the Agilent MassHunter Workstation Software and MSD ChemStation Data Analysis Software.

Microsoft®, Windows 7®, and Excel® are registered trademarks of Microsoft Corporation in the U.S. and/or other countries.

HP® is registered trademark of HP Company in the U.S. and/or other countries.

Canon® is registered trademark of Canon Inc. in Japan and/or other countries.

© Agilent Technologies, Inc. 2015

Seventh edition, October 2015

G1701-90112

www.agilent.com

Agilent Technologies